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Read me first

The ICDL® Qualification

The International Computer Driving Licence® (or ICDL®) is the worldwide qualification which

enables people to demonstrate their competence in computer skills. The ICDL® consists of

seven module tests, which lead to the qualification.

The ECDL® Qualification

The European Computer Driving Licence® (or ECDL®) is the name by which the qualification

is known in Europe.

ICDL for Educators Courseware

The ICDL for Educators courseware consists of the seven ICDL modules with a specific

focus on classroom use, plus additional Pupil Projects. The result is an ICDL experience that

is totally in context for schools.

The courseware addresses all the skills covered in the International Computer Driving

Licence® syllabus, therefore on completion of the courseware learners should feel confident

to undertake their ICDL® qualification.

ECDL for Educators Courseware is accredited by the ECDL Foundation Limited.  

The ECDL Foundation is the global governing body for ECDL® and ICDL® 

accreditation. 
 

E

European Computer Driving Licence, ECDL, International Computer Driving Licence, ICDL, e-Citizen and related logos are trade marks of The
European Computer Driving Licence Foundation Limited (“ECDL-F”) in Ireland and other countries.

Aston Swann and co is an entity independent of ECDL-F and is not associated with ECDL-F in any manner. This courseware publication may be
used to assist candidates to prepare for ECDL/ICDL tests. Neither ECDL-F nor Aston Swann and co warrants that the use of this courseware
publication will ensure passing of ECDL/ICDL tests. This courseware publication has been independently reviewed and approved by ECDL-F as
complying with the following standard:

Technical compliance with the learning objectives of ECDL/ICDL Syllabus Version 4.0.

Confirmation of this approval can be obtained by reviewing the Courseware Section of the website www.ecdl.com

The material contained in this courseware publication has not been reviewed for technical accuracy and does not guarantee that candidates will
pass ECDL/ICDL tests. Any and all assessment items and/or performance-based exercises contained in this courseware publication relate solely
to this publication and do not constitute or imply certification by ECDL-F in respect of ECDL/ICDL tests or any other ECDL-F test.

For details on sitting ECDL/ICDL tests and other ECDL-F tests in your country, please contact your country's National ECDL/ICDL designated
Licensee or visit ECDL-F’s web site at www.ecdl.com.

Candidates using this courseware publication must be registered with the National Licensee, before undertaking ECDL/ICDL tests. Without a
valid registration, ECDL/ICDL tests cannot be undertaken and no ECDL/ICDL certificate, nor any other form of recognition, can be given to a
candidate. Registration should be undertaken with your country's National ECDL/ICDL designated Licensee at any Approved ECDL/ICDL Test
Centre.

ECDL/ICDL Syllabus Version 4.0 is the official syllabus of the ECDL/ICDL certification programme at the date of approval of this courseware

publication
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The Learning

ICDL for Educators Courseware can be delivered as a face-to-face (tutor led) programme,

as a self-study option, as workshops; or any combination of these options.

ICDL for Educators Courseware can be managed and supported on-line through Managed

Learning Environments, Virtual Learning Environments and Virtual School Environments.

The Content

Module 2: Using the Computer and Managing Files

� The courseware for this module is contained within this workbook

� The workbook consists of 2 Parts

Each Part takes approximately 1.5 hours to complete

� Each Part is broken down into Examples

The Examples are based on classroom related documents.

Each Example is broken down into a series of Exercises

� The Exercises cover the steps necessary to create the document in the current

Example

Each Exercise is written in a click-by-click format

The Exercises within the workbook cover the full range of the ICDL syllabus skill requirements

for this module. It is important that learners complete this module in full, in order to have

covered all of the syllabus requirements for Module 2.

It is also important to begin with Part 1, and work through to the end of Part 2, as the module

builds upon the skills learned in the earlier Exercises.

This ECDL Foundation approved courseware product incorporates

learning reinforcement exercises. These exercises are included to

help the candidate in their training for the ECDL/ICDL®. The

exercises included in this courseware product are not ECDL/ICDL®

certification tests, and should not be construed in any way as

ECDL/ICDL® certification tests. For information about Authorised

ECDL/ICDL® Test Centres in different National Territories, please

refer to the ECDL Foundation website at www.ecdl.com.

http://www.ecdl.com/
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Opening and Saving Files

Some of the Exercises contained within this module require learners to open pre-prepared

files, and to save these files and others created during the training into the learner’s filing

system.

The pre-prepared files will initially be contained on a CD. It is the responsibility of the licence

holder to provide learners with a CD containing all the pre-prepared files. If this is not

practical, it is the responsibility of the licence holder to provide learners with the pre-prepared

files electronically (locally, via Intranet or via a secure Internet web site). In this instance, the

licence holder should advise learners of the location of the files.

The Exercises give click-by-click instructions on how to open the pre-prepared file(s) from the

CD, and how to save files to the [My Documents] folder, or another, appropriate folder. If it is

not practical to save files to the [My Documents] folder, it is the responsibility of the licence

holder to advise learners of the drive, folders and sub-folder(s) in which the files should be

saved.

Instructions

Throughout the courseware, the following methods have been used:

� Instructions are indicated by a bullet

� The result of the instruction is a sub-bullet below

Exercise information is written without a bullet
Additional information is written in italics

We use the word “Click” for a button

We use the word “Select” for a menu

We use square brackets to indicate a [button name] and [menu name].

ICDL for Educators courseware is authored by Aston Swann and accredited by the ECDL Foundation Ltd.

ICDL for Educators courseware is a part of the ECDL for Educators courseware suite authored by Aston Swann.

All rights reserved.

V4.XP.03.06

Please contact us with any queries or feedback about this courseware:-

Aston Swann & Co.

Suite 1, 26-28 Aubrey Street, Hereford HR4 0BU, UK

T: +44 (0) 8454 304051

F: +44 (0) 8454 304052

E: ws@educatorsecdl.com

W: www.educatorsecdl.com

http://www.educatorsecdl.com/
mailto:ws@educatorsecdl.com
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Introduction to Windows

Windows Explained

Windows is a Graphical User Interface (GUI) enabling the user to recognise

where they would like to go on their computer by pointing and clicking the

mouse on Menus and Icons. Windows does away with the need for the user

to learn a computer language in order to use their programs.

Windows Jargon

GUI Graphical User Interface

WIMP! Windows, Icons, Mouse, Pointer.

DOS Disc Operating System

The Mouse

The Mouse is a simple piece of hardware usually made up of a ball bearing

and sensors. It is important to keep the ball bearing clean and free from dust

so that the Mouse Pointer mirrors accurately the movement of the hand on the

Mouse Mat. There are other ‘pointing’ devices that can be used with Windows

such as fingers and pens for touch sensitive screens. Optical mice are

becoming more common place. In an optical mouse, the ball bearing is

replaced with an optical sensor – which does not need cleaning, and can be

used on most surfaces without the aid of a mouse mat.

Mouse Techniques:

The Mouse is used extensively in Windows. The left Mouse Button is for

selecting Buttons and Menu Options. The right Mouse Button is for accessing

context sensitive menu options.

Click

Pressing and letting go of a mouse button once. One click will select a

required item (for example, a menu item).
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Double click

Clicking a mouse button twice in rapid succession. A double click activates an

icon. If this is done too slowly, the computer interprets it as 2 separate clicks

– and will not carry out the action expected from the double click. The speed

expected for a double click can be decreased or increased if required.

Mouse Pointer

As you move the mouse around, the mouse pointer on screen moves

accordingly; showing you where the mouse will currently be active on screen.

The Desktop

The desktop is the initial Windows screen. It gives you access to all of your

Windows functions; along with all your programs and documents.

Icons

Icons are pictures on the Desktop that link the user to programmes or

document files.

To activate, double click on the icon.

• [Microsoft Outlook] is the application that will allow you to send and

receive e-mails, keep a calendar for your appointments, store details

of your regular contacts, maintain a task list, and keep notes

• [Recycle Bin] is the disk space for holding files deleted from your

hard disk

� Files deleted from the Recycle Bin are not recoverable

Other icons may be present, dependent upon what software has been loaded

onto your PC.
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A Window

Each program you run will be contained in its own ‘window’ – a rectangle on

screen containing everything to do with that program.

Multiple windows can be opened at the same time; allowing you to move

between programs and documents with ease.

The Taskbar

The Taskbar is the strip at the bottom of the Desktop.

It contains the [Start] button and may show various other settings.

• Hover the mouse over the [Time] icon to see the [Date]

• For each open window, there will be a button on the Taskbar

� These buttons can be used to switch between the Windows you have

opened.

Dialog Box

A window containing fields to select relating to a command.

Field

An area in a dialog box, either containing information about that dialog box, or

for you to enter information/choices.

Logging on

Windows enables you to Log on using your own User Name to access your

own Network Drives and Profile Settings.

The Time Icon

Start Button Window Button
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Example 1 – Getting Started

Exercise 1 Start the computer

Every make of computer is slightly different; therefore the location of ‘on’ and

‘off’ switches and other functions will vary from make to make. However, once

you have determined where these are located on your computer, the

procedure to start the computer is the same.

• Ensure that the computer and screen are plugged in and switched on at

the wall, etcetera

• Locate the power switch on your system unit and turn it on

� The monitor may automatically be switched on with the computer

� If not, locate the power switch on the monitor and turn it on

• Wait whilst the computer powers up and runs through its self tests
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Exercise 2 Log on to the network

If your computer is attached to a network, rather than you working ‘stand-

alone’, your first task will be to log on to the network.

This involves entering your username and password in order for you to access

the network filing system and additional facilities, such as shared printers.

If you do not need to log on to the network, the following step will be skipped.

A dialog box will open on screen, for you to enter the necessary information.

• Move the mouse pointer over the field to the right of the [User name:]

• Click once with the left mouse button

� To select this field

� To be able to enter your user name in this field

• Type your user name into the [User name:] field

• Move the mouse pointer over the field to the right of [Password:]

• Click once with the left mouse button

� To select the [Password:] field

• Type your password into the [Password:] field

� To see your password being shown as a series of asterisks (***)

� The asterisks ensure the privacy of your password

• Click the [OK] button in the dialog box

� When you have finished entering your user name and password

� To log you onto the network

� To open Windows on your computer
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Example 2 – Understanding Windows

Exercise 3 The Start menu

When you first turn the power on to your computer, Windows will load a

landscape view ‘Desktop’ area with a blue strip at the bottom called the

[Taskbar]

The [Start] button is on the bottom left corner of the Taskbar

The [Start] button is one way to access all of the programs that are available

to you on your computer

• Move the mouse so that the pointer is directly over the [Start] button

• Click your left mouse button once

� The [Start] menu pops up

The Desktop
The Start button
© Aston Swann 2006

The Taskbar
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• Without clicking, move your mouse pointer up and down the [Start] menu

� As you move the mouse pointer over each item, that item will be

highlighted

• Hover over a menu option with a right facing triangle

� A sub-menu will be shown for that menu option

� It’s very sensitive, and can be quite tricky!
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The [Start] menu contains many options

Look, but don’t click just yet! These are the choices:

[Turn Off Computer] The safe place to go to close down your computer

[Log Off] The place to go to close down your programs and
log off, or for leaving your programs running and
switching to another user

[Run] One way to open a file or program

Great for those CD’s that won’t automatically load!

[Search] Can’t remember the name of the file you saved – or
where you saved it to? Use [Search]

[Help and Support] Search for advice on any Windows topic.

Also, takes you to the set-up area for your
computer

[Printers and Faxes] Shows installed printers and fax printers and helps
you add new ones

[Connect To] One way to connect to the Internet and other
networks

[Control Panel] Enables you to customize the functionality and
appearance of your computer

[My Network Places] Gives access, to and information about, folders and
files on other computers

[My Computer] Gives access to, and information about, disk drives,
cameras, scanners and other hardware connected
to your computer

[My Music] A place to store your music and other audio files

[My Pictures] A place to store digital photos, images and graphics
files

[My Recent Documents] A shortcut to the last 15 documents that you have
used

[My Documents] A place to store letters, reports, notes, and other
kinds of documents

The left hand side of the [Start] menu will contain shortcuts to programs you

use frequently.
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Exercise 4 Manipulate Windows

We will use a program called Paint to become familiar with the various parts of

a window within a program, and to practise using the mouse to manipulate

windows on screen.

• Click on [Start] [All Programs] [Accessories] [Paint]

� To open the Paint program in its own ‘window’

• Look at the various parts of the window

� The solid coloured band at the top is called the ‘Title bar’

� The document name and the program name appear on the top left of

the title bar

� Three ‘navigation buttons’ appear at the top right of the title bar

� The menu bar is under the title bar, and gives access to all the

functions available within this program.

� Scroll bars are shown if it is not possible to view all the contents of your

current file on screen at once. They can be used to move up/down and

left/right through the document

� The Status bar may be seen at the bottom of the window. This gives

information as you are working in your current program

Menu bar

Toolbar

Status bar

Document Name & Program Name The Navigation buttons

Scroll bars

The Title bar
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The Navigation buttons

The navigation buttons are [Minimise], [Restore Down/Maximise] and [Close].

To try these buttons out::

Close

• Click [Close] once with your left mouse button

� This is the cross in the top right corner of the screen

� The Paint window shuts down

• Click on [Start] [All Programs] [Accessories] [Paint]

� The Paint program opens again

Tip:

If you have made any changes to a document in a window, Windows will

always ask you if you want to save the changes before closing the window.

Minimise Restore

Down/

Maximise

Close

To shrink

the window

and put it to

one side as

a button on

the task bar

To display a

window so

that you can

manually

resize it

Kiss the

window

goodbye!
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Minimise

• Click [Minimise] once with your left mouse button

� This is the button with the dash in the top right corner of the screen

� This does not close the window

� The window shrinks itself to become a button on the Taskbar

Tip:

This ‘hides’ your window whilst you are working on something else, without

closing down the program and the document you are working on.

• Click on [Untitled – Paint] on the Taskbar

� The Paint window restores

� The window is the same size and in the same position as before it was

minimised

Minimise

The minimised window sits on the Taskbar
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Maximise/Restore Down

• Click [Maximise] once with your left mouse button

� The window fills the entire desktop

� Any other open windows would be ‘hidden’ behind this window

� The middle navigation button becomes [Restore Down]

• Click [Restore Down] once with your left mouse button

� The window restores to its previous size and position on the desktop

� The remainder of the desktop may be seen around the window

� The middle navigation button becomes [Maximise]

Maximise
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Resizing and Moving Windows

When a window is ‘restored’ – and therefore does not fill the entire desktop –

it is possible to change its size, shape and position.

• Position your mouse over one of the edges of the window pane

� The mouse pointer becomes a double-headed arrow

• Hold down the left mouse button

� To anchor the pointer

• Drag the mouse left/right or up/down, then release the left mouse button

� To manually resize the window

� To view scroll bars if the window becomes too small to see its entire

contents

• Move the mouse pointer onto the coloured Title bar of the window

• Hold down the left mouse button and move the mouse

� To drag the window around the Desktop

� To move the window and reposition on the desktop

• Click [Maximise]

� To make the window fill the entire desktop again

Drag the Title bar to reposition

Drag the cursor
to resize
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Example 3 – Working with files

Exercise 5 Mouse control

We will use the Paint program that is currently open on screen to practise

mouse control by creating a drawing.

Down the left hand side of the Paint window is the Tool Box, containing

buttons to select the tools you wish to use to create your drawing.

• Click once on a tool in the Tool Box

� To select that tool

• Position the cursor in the screen

• Hold down the left mouse button

• Click and drag the cursor

� To draw with that tool

� To form a shape

• Click on a different tool in the Tool Box

� To select that tool for your next shape

� To deselect the previously selected tool

Select

Fill with Color

Ma gnifier

Brush

Text

Curve

Polygon

Rounded Rectangle

Free-Form Select

Eraser

Pick Color

Pencil

Airbrush

Line

Rectangle

Ellipse

Colour

Options for currently

selected tool
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• Click on a colour in the Color Box at the bottom of the screen

� To select the colour for your next shape

• Click on the [Fill with Color] button in the Tool Box

• Select a colour from the Color Box

• Click inside one of the shapes you have drawn

� To fill that shape with the colour you have just selected

• Experiment with the different drawing tools to draw a bunch of balloons

with:

� Different weights of line

(Before drawing a line, select the weight you require from the choices

at the bottom of the Tool Box)

� Straight and curved line strings

� Oval and circular balloons

� Different fill colours

� Different outline colours and weights
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Exercise 6 Save a file

This exercise will save your drawing into your electronic filing system.

• From the menu bar, select [File] [Save]

� The Save As dialog box will open

� The [File name:] field will be selected

• Type the name ‘Balloons’

� To replace the suggested name for the file

• From the available locations, click on the [My Documents] icon on the left

of the screen

� To select this as the folder in which to place the document

� To show [My Documents] in the [Save in:] field

• The [Save as type:] field will show [24-bit Bitmap]

� This is the file format that will be used

Further file formats will be seen and discussed later in this Module

• Click the [Save] button

� To save this drawing as a Bitmap file in the [My Documents] folder
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Exercise 7 Copy & Paste

This will copy your balloons and paste the copy elsewhere on screen.

Whenever anything is cut or copied within Windows, it is stored in an area

within Windows called the Windows Clipboard. An item you place on the

Windows Clipboard will remain there until another item replaces it, or you

close down.

• Click on the [Select] tool in the Tool Box

• Click and drag the mouse cursor around your balloons

� To draw a rectangle around your balloons

� To select your balloons as the area of the screen you wish to work with

• From the menu bar, select [Edit] [Copy]

� To take a copy of your drawing

� To put this copy of your drawing onto the ‘Windows Clipboard’

� To be able to paste this copy of your drawing into a different position in

this or any other document you open on screen

• Select [Edit] [Paste]

� To paste a copy of your balloon selection onto the screen

• Whilst the pasted copy is still selected, drag the selected

object with the moving cursor

� To position the new balloons where you want them in the picture
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To deselect the object:

• Move the cursor away from the balloons

• Click the left mouse button in an empty space

� To ensure that you are no longer working with the object

To update your work:

• From the menu bar, select [File] [Save]

� As the file is already saved safely with a file name and “path”, this will

amend the saved file to include the changes you have made

Tip:

If you wished to save the file either with a different name, or in a different

location, selecting [File] [Save As…] from the menu bar would open the Save

As dialog box again, allowing you to change the name and/or location for the

updated file.
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Exercise 8 Print your work

If you are working on a network, you will probably have access to more than

one printer each time you print your work. For example, sometimes you may

need to use a laser printer – for speed; whereas other times you may be

better using a colour inkjet printer if you are printing graphical documents.

One of the printers available to you will have been set up as your ‘default’

printer. This means that each time you send a document to print; this printer

will be used, unless you specify at the time of printing that you wish to use a

different printer.

It is therefore important to ensure that you select the correct printer each time

you send your work to print – and also that you know how to check the

progress of the print job and, if necessary, stop the print .

Print your document

• From the menu bar, select [File] [Print]

� The Print dialog box will open

� Your default printer will be shown in the [Name:] field

• Click the drop down arrow to the right of the [Name:] field

� To view a list of the printers available to you

� To select a different printer, if required

• Amend the [Number of copies:] field

� If you require more than one copy of your document

• Amend the Page range section

� If you do not wish to print the entire document

If you need to print random pages, follow the instructions under the

[Pages:] field to enter the page numbers you require

• Click [OK]

� To send your document off to print, with the options you have selected
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Tip:

If at any time you are working with more than one program open at the same

time, it is possible to change to different printers for each program. For

example, you may select a laser printer to use within your word processing

program today, whilst you wish to use a colour inkjet printer for a presentation

you are creating and printing out.

Until you finish the session, each program will remember the printer you have

specified for that program, and will automatically use the laser printer for any

word processing documents you send to print, whilst staying with the colour

inkjet printer each time you print out part of your presentation.
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Preview your work before you commit it to print

You may find that when you send your document to print, it does not fit onto

the page as you would wish, and you may need to change the orientation of

the paper (turning the paper round from Portrait to Landscape), or to move

your work to different positions on the page.

A Print Preview can check these things before sending the document to print.

• From the menu bar, select [File] [Print Preview]

� The first page of your document will be shown on screen, as it will print

out

• Click the [Next Page] or [Prev Page] buttons

� If you have more than one page in your document, in order to see the

other pages in the document

Either

• Click [Close]

� To shut down the Preview

� To make any alterations you wish to the document

Or

• Click the [Print] button in the Print Preview screen

� To print the document as it is now
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Exercise 9 Print management

The printer settings allow you to install new printers, to see the print jobs that

have been sent to the printer, to view their progress and, if necessary, to

cancel your own print jobs.

• Click the [Start] button on the Taskbar

• Select [Printers and Faxes]

� The [Printers and Faxes] window opens

� A list of available printers is shown
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View the Print Progress

• Double click on the printer icon you are using

� To open a window for that printer

� To view the documents that have been sent to this printer

Pause a document print

• Click on your document name

� To select that document

• From the menu bar, select [Document] [Pause]

� To pause this print job

Re-start your paused document

• Click on your document name

� To select that document

• From the menu bar, select [Document] [Resume]

� To re-start this print job

� To unmark [Pause Printing] from the menu
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Stop your document from printing

• Click on your document name

� To select that document

• From the menu bar, select [Document] [Cancel]

� To cancel the print command

� To delete this print job from the list

• When asked “Are you sure you want to cancel the selected print jobs”,

select [Yes]

• [Close] the window for your printer

Tip:

Memory can travel from your computer to the printer very quickly – leaving

very little time to open the printer window and pause or cancel a print.

Tip:

Whilst your document is being processed for printing, a printer icon will be

shown at the bottom right of the Taskbar (near the clock), specifying that you

are printing at present. Double click this icon to open the print status dialog

box for that printer, and access the menu commands as described above.
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Change the default printer

From the Printers and Faxes dialog box, it is possible to change the default

printer – the one that will automatically be used whenever you send a

document to print, unless you state otherwise at the time of printing.

• In the Printers and Faxes dialog box, right-mouse click over the printer you

wish to make the default

� A quick menu of printer options will open

• From the quick menu, select [Set as Default Printer]

� To select this printer as the default from now on

� To see that a tick has been placed next to the chosen default printer

• [Close] the Printers and Faxes dialog box
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Tip:

If your document does not print, an error message may be sent to your

computer.

Alternatively, when you are printing a document, an icon of a printer will

appear on the Taskbar near the clock. If there is a problem with the

printer, a question mark will be attached to the printer icon.

Check the following for your printer:

Is it out of paper?

Is it out of toner?

Is the paper jammed?

Is the printer switched on?

Is there a network error?
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Installing a Printer

Most printers can be installed to a computer using a device called “Plug and

Play”. This means that once you have plugged the printer into the PC, you

should be able to use the printer straight away, without the need to configure it

or install additional software. If you have an older-style printer (normally pre-

1995), your printer may be “non Plug and Play”, and you may have to

configure it or install additional software.

Installing a Plug and Play Printer

Most printers manufactured since 1995 are Plug and Play – this means that

you can connect your computer to a printer and start using it, simply by

plugging the printer lead into the back of your computer.

• Connect the printer cable to the appropriate port on your computer

• Plug the power cord of the printer into a wall outlet and turn the printer on

� Windows will detect your Plug and Play printer and, in many cases,

install it on to your computer without requiring you to make any

selections

� The Printer is ready to print

If the [Found New Hardware Wizard] appears:

• Select the [Install the software automatically (Recommended)] check box,

click [Next], and then follow the instructions

� The printer is now installed to your computer

If windows does not detect your Plug and Play printer, you may need to install

it using the [Add Hardware Wizard] – see section below.
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Installing a non Plug and Play Printer

• From the [Printers and Faxes] window, refer to the [Printer Tasks] pane

and select [Add a Printer]

� To start the [Add Printer Wizard] which helps you to install a printer,

step-by-step

• In the first [Add Printer Wizard] window, read through the instructions

� To check the steps to take if your printer is a “plug and play” printer – if

so, close the wizard screen and follow the instructions given above

• Click on the [Next] button

� To take you to the next step

• At the [Local or Network Printer] wizard, select whether you are installing a

local or network printer

� A "local printer” is a printer that is connected to the computer you are

using and only accessible from this computer

� A “network printer” is a printer that is accessed through a network and

is available from more than one computer

• Click on the [Next] button

• At the [Specify a Printer] window, search for the printer you wish to

connect to

� This is only necessary if you are unable to locate the printer to connect

to

� This step is not necessary if you have already chosen your printer in

Step 2 of the Wizard – [Local or Network Printer]

• Click on the [Next] button

• In the [Browse for Printer] window, select the printer required from the

ones you have searched for

� This will enable you to confirm the printer you require after searching

for it in the previous window

� This step is not necessary if you have already chosen your printer in

Step 2 of the wizard – [Local or Network Printer]

• Click on [Next]

� To close the wizard

� To install the printer to your computer
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Exercise 10 Close your work

This will close down the Paint program, together with the document you have

been working on.

If you have made changes to a document and have not saved them, Windows

will always ask you if you wish to save the changes before it shuts the

program down. (Unsaved work is held in the memory of the computer, and

this memory is cleared when a program is closed. Consequently, any

unsaved work would be lost if the program were shut down or if there were a

power cut.)

Either

• From the menu bar, select [File] [Exit]

Or

• Click the [Close] button at the top right of the Title bar

• If you are asked if you wish to save changes, click [Yes]

� If you do wish to keep them.
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Exercise 11 Open and close your work

There are several methods of opening your saved work, depending upon how

long it is since you last opened it, and how many documents you have worked

on since then.

My Recent Documents Menu

The [My Recent Documents] menu stores the location of the last 15

documents you have saved, regardless of the program they were created in.

• Click the [Start] button on the Task bar

• Select [My Recent Documents]

• Select [Balloons] from the list of documents

� The Paint program will open, with [Balloons] on screen

• [Close] the Paint program

The [File] Menu

Within most programs, the [File] menu stores details of the most recently

saved documents in that program.

• Select [Start] [All Programs] [Accessories] [Paint]

� To open the Paint program

• From the menu bar, select [File]

• Select the [Balloons] file from the list towards the bottom of the menu

� [Balloons] will open on screen

• [Close] the Paint program.
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If your document does not appear in the [File] menu:

• Select [Start] [All Programs] [Accessories] [Paint]

� To open the Paint program

• From the menu bar, select [File] [Open]

� The Open dialog box will be shown

• Click the drop down arrow to the right of the [Look in:] field

� To view all the filing locations on your computer

• Click on the [My Documents] folder

Either

• Double click on [Balloons]

Or

• Click on [Balloons]

• Then click the [Open] button

� To open the [Balloons] file on screen

• [Close] the Paint program
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My Computer

[My Computer], which can be located by clicking on the [Start] button, shows

all the filing locations available to you, plus the hardware installed on your

computer.

Within [My Computer], you may find that each time you select a drive or folder

to view, a separate window is opened for this – consequently, you may end up

with multiple windows open. You will then need to [Close] each of these

windows separately when you have finished.

• Click on the [Start] button

• From the [Start] menu, select [My Computer]

� To view the contents of the [My Computer] folder

• In the [Other Places] pane at the left of the [My Computer] window, select

[My Documents]

� To view the contents of the [My Documents] folder

• Double click [Balloons]

� To open the Paint program with [Balloons] on screen

• [Close] the Paint program
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Note:

The contents of [My Documents] relate to the person who has logged onto

the computer. When viewing the contents of [My Computer], the [My

Documents] folder may be shown as [xxx’s Documents], where “xxx” is the

name of a user with a logon for this computer.

In the example above left on the previous page, “Training” is the user

name of the person currently logged on to the computer, and the [My

Documents] folder is called [Training’s Documents] when it is viewed in the

[My Computer] window. This is to differentiate between the documents

folders of all the users who have logins on this computer.

Selecting [My Documents] from the [Other Places] pane will always open

the documents folder of the currently logged on user.
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Exercise 12 Restart the computer

If you are having a recurring problem, such as a program constantly freezing

on screen, restarting the computer can often ‘clear out’ the problems and

allow you to carry on working. (See note overleaf.)

It is important that the computer is always shut down and restarted properly.

This ensures that all programs that are running (both those you have been

working on and the system programs that run in the background whilst you

are working) are correctly closed, and any information held in the computer’s

memory is filed away correctly, ready for next time you use the computer. It

will also ensure that you are correctly logged off from the network, if

applicable.

• Click the [Start] button on the Taskbar

• Select [Turn Off Computer]

� The Turn Off Computer dialog box will open

• Ensure that [Restart] is selected

� To correctly shut down and restart your computer

• When the computer restarts, if necessary, log on to the network as normal
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Note:

If the application fails to respond and will not close down using the normal

route, hold down the [Ctrl] and [Alt] on the keyboard, then, whilst they are still

held down, press and let go of the [Delete] key. The Task Manager window

will open. Click on the [Applications] tab, select the non-responsive

application and then select [End Task]. Depending on the problem with the

application that has failed to respond, it may well be necessary to re-start the

computer before opening the application again.
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Exercise 13 File management

Your filing system stores all the documents that you save, along with the files

that are used by the system to run your programs.

The filing system encompasses all the places files can be stored:

• In folders on the hard disk inside your PC

• In folders on a network drive stored on a server to which you have access

• On a removable disk (such as a Floppy Disk or other removable storage

device)

• On a CD ROM

Setting up an efficient filing system is important for several reasons. You

need to be able to easily find your files again in the future. You need to

ensure that you do not accidentally tamper with the system files (this could

prevent your programs working). If you share network drives and folders with

other users, you need to ensure that you work effectively together.

Your filing system can be most easily accessed and maintained from within

[My Computer].
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Exercise 14 Exploring [My Computer]

• Select [Start] [My Computer]

• Select the [Folders] icon on the toolbar

� The left hand pane (The Folders pane) contains a ‘folders tree’,

showing how the drives and folders link together

� The right hand pane (The Contents pane) shows the folders and files

contained in the drive or folder currently selected in the Folders pane

� The icons to the left of the drives, folders and files indicate what each

is:

• The Desktop

Contains the icons relating to programs, files and shortcuts that

are held on the Desktop.

• The [My Computer] Icon

All your available drives and folders are contained within My

Computer.

The Folders pane The Contents pane
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• A floppy disk

Usually removable. Only small amounts of information can be

stored on a floppy disk, and they tend to be used to back up information

stored elsewhere.

• A hard disk

Usually permanently located within your computer. Your hard disk can be

used to store your programme application files and the majority of your

own work in your filing system.

• A folder within a drive

Part of your filing system - a bit like a drawer in a filing cabinet.

This folder is currently selected, it is open. The contents will be

shown in the Contents pane.

• A CD drive/DVD drive

CD/DVD drives can be read only drives (known as ROM – read only

memory), or read/write, dependent upon whether you have a CD/DVD

writer installed on your PC. Large amounts of information can be stored

on each CD, and even larger amounts on DVDs.

• A network drive

When your computer is connected to other computers it is said to

be “networked” and can securely share drives, folders, files, printers, etc.

All the network drives you currently have access to will be shown.

• The Recycle bin

Files deleted from the hard disk will be put in the Recycle bin, and

can be retrieved from there if necessary. Once you empty files out of the

bin, they are permanently deleted from your computer, and you cannot

recover them.
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• Printers

This opens the Printers folder, showing all the printers you currently have

access to. From here you can install new printers, change your default

printer and check the settings of your existing printers

• The files shown in the Contents pane usually have an icon

identifying the program with which they will be opened and edited.

For example, an Excel spreadsheet file will have the Excel icon to the left of

it.

You may also see other removable devices that have been installed on your

PC, eg

• Scanners and Cameras

Allow you to download pictures and text to your computer

• Removable disks

For additional storage
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Working with the Folders pane

• Look at the Folders pane

� A drive or folder with a [-] sign next to it – indicates that it has

subfolders, and that these are currently on display underneath the drive

� A drive or folder with a [+] sign next to it – indicates that it has

subfolders, but that these are not currently shown

• Click the [+] sign to the left of one of the entries in your Folders pane

� To open up the list of subfolders for this entry

� To view the subfolders beneath the folder

• Click the [-] sign to the left of one of the entries in your Folders pane

� To hide the list of subfolders for this entry

• Ensure that your [My Documents] folder has a minus sign next to it

� So that you can see the subfolders for this folder in the Folders pane

• Click on your [My Documents] folder in the Folders pane

� Any subfolders and files contained within the [My Documents] folder

will be shown in the Contents pane

� The [Balloons] file will be shown in the Contents pane
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Tip:

File pathnames can be up to 255 characters long, although it is wise to limit

yourself to far fewer characters, for ease of use later. The following

characters cannot be used in file names, as they are used by the system:

Forward slash /

Back slash \

Greater than sign >

Less than sign <

Asterisk *

Question mark ?

Quotation mark “

Pipe symbol |

Colon :

Semicolon ;

Tip:

Note how the white [Address] strip indicates the “File Path” or location

eg: My Documents.
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Working with the Contents pane

• From the menu bar, select [View] [Details]

� The Contents pane will now show columns displaying details about the

folders and files contained within it

• Look at the [Balloons] file

� The icon to the left of the file details will show that it was

created using the Paint program

� The [Name] column will show the file name

� The [Size] column will show how big the file is

Files are measured in kilobytes (kb) until the file reaches 1,000 kb,

when it is shown in megabytes (mb)

� The [Type] column will show whether this is a folder, an application or a

particular type of file

Windows is usually set up to associate particular file types with

particular programs, so that when you choose to open a file, Windows

knows which program to open in order to edit it

� The [Date Modified] column shows the date and time that the file was

last updated

Tip:

We are looking at the details for a file, but the same information on name,

type and date modified will be displayed for any folders shown in the

Contents pane.
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File Extensions

Displaying the file details shows the [Type] for each file.

Another way of ascertaining the file type is by looking at the extension at the

end of the file name. Whenever a file is saved within a program, a full stop –

followed by an additional 3 letters – is automatically added after the file name.

This 3 letter extension signifies the type of file being saved.

Tip:

If the file extension is removed from a document, the computer will not know

which program to use to open that document. It is said to lose its “association”

with the originating program.

If the file extensions are not shown within your current folder; to view the file

extensions:

• From the menu bar, select [Tools] [Folder Options…]

� The Folder Options dialog box will open

• Click the [View] tab across the top of the dialog box

• Click on [Hide file extensions for known file types]

� To remove the tick from this box

• Click [OK]

� To view the file extensions in your current folder
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Some of the most commonly used file types, examples of programs of this

type, and the extensions for these programs are as follows:

File type
Example of

program
Program uses

Program

extensions

Word

processing

Microsoft

Word

Letters, reports, text based

documents

.doc

Spreadsheets Microsoft

Excel

Calculations and manipulating

numbers

.xls

Database

files

Microsoft

Access

Lists of information (for

example, the phone book)

.mdb

Presentation

files

Microsoft

PowerPoint

Displaying information in a

graphical format

.ppt

Image files Examples are photographs,

scanned pictures, graphics

These files can be saved in

many formats

.gif

.jpg

.bmp &

others

Audio files For listening to sound and

music

A compressed audio/video file

.wav

.mpeg

Video files

Created and

edited in a

large variety

of programs

For viewing animated video

A compressed audio/video file

.avi

.mpeg

Compressed

files

Winzip

Stuffit

To “zip”, or compress files so

that they take up less memory

.zip

.hqx .bin

Rich Text

Format

Enables a document to be

viewed in a standard format via

different word processing

packages

.rtf

Temporary

files

Files that store temporary

information should be

periodically cleaned off your

machine

.tmp

For a comprehensive list of file extensions and associated programs, visit
www.stack.com/file/extension/index.html

http://www.stack.com/file/extension/index.html
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Exercise 15 Create a new folder

This will create a new folder within your [My Documents] folder, and will also

add subfolders into this new folder.

• In the Folder pane, click on [My Documents]

• From the menu bar, select [File] [New] [Folder]

� A new folder will be added in the Contents pane

� The cursor will be flashing in the folder name, ready to give it a name

• Type in your department’s name and press [Enter]

� To name your folder

• In the Folders pane, click on your new folder

� To look at its contents

� To see that it is empty!

• Ensure that your new folder is still selected in the Folders pane

• From the menu bar, select [File] [New] [Folder]

• Name it “Class 1” and press [Enter]

• Select your departmental folder in the Folders pane

• Create three more new folders for “Class 2”, “Class 3” and “Class 4” in the

same way
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Exercise 16 Rename a folder or file

A folder

• In the Folders pane, click on [Class 1]

• From the menu bar, select [File] [Rename]

• Type in “Form 1” and press [Enter] to confirm what you have typed

• Rename the other three folders as “Form 2”, “Form 3” and “Form 4”

A file

• In the Folders pane, click on [My Documents]

• In the Contents pane, click on [Balloons.bmp]

• From the menu bar, select [File] [Rename]

� [Balloons.bmp] will be highlighted, ready to change the name

• Click at the beginning of the file name and type “Some”

• Press [Enter]

� To rename the file [Some Balloons.bmp]
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Exercise 17 Copy a document

Files can be copied from one folder or drive to another, to make duplicate

copies in other folders and/or drives. The file contents will be identical, but will

not be linked in any way; therefore editing the file that is stored in one location

will not make any changes to the identical file(s) stored in other locations.

When a file is copied, it is placed on the Windows clipboard – an area on

your computer where data you have copied is temporarily stored. Copied

data is available to be pasted into any program you have access to on your

computer, not just the program from which it was copied. Once data has been

copied, it can be pasted as many times as you like, until you copy another

piece of data – which will overwrite the previously copied data on the

clipboard.

• In the Folders pane, select your [My Documents] folder

• In the Contents pane, select the [Some Balloons.bmp] document

• From the menu bar, select [Edit] [Copy]

� To put a copy of the [Some Balloons] document onto the Windows

clipboard

• In the Folders pane, click the [Form 1] folder

• From the menu bar, select [Edit] [Paste]

� To paste a copy of [Some Balloons] into the [Form 1] folder

• In the Folders pane, click the [Form 2] folder

• From the menu bar, select [Edit] [Paste]

� To paste a copy of [Some Balloons] into the [Form 2] folder

• Paste the balloons document into the [Form 3] and [Form 4] folders in the

same way

Tip:

Selecting [Edit] [Cut] from the menu bar instead of [Edit] [Copy] would move

the file from the original location to the destination folder or drive.

When you [Cut] a document, the original is removed from the location until

you [Paste] it into the new folder. Be careful not to overwrite and lose the “cut”

item with a second [Copy] command! (see above).
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Copying folders

An entire folder (including its contents) can be copied between folders and

drives, using the same procedure as outlined above for copying files between

folders.

• In the Folders pane, select your departmental folder

• In the Contents pane, select the [Form 1] folder

• From the menu bar, select [Edit] [Copy]

� To put a copy of the [Form 1] folder onto the Windows clipboard

• In the Folders pane, select the [My Documents] folder

• From the menu bar, select [Edit] [Paste]

� To paste a copy of the [Form 1] folder into the [My Documents] folder

� This copy of the [Form 1] folder will also contain another copy of the

[Some Balloons] file, that was copied into it in the previous exercise

Tip:

As with files, selecting [Edit] [Cut] from the menu bar instead of [Edit] [Copy]

would Move the folder and its contents from the original location to the

destination folder or drive.
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Exercise 18 Change folder view

The files stored within a folder can be displayed in various view formats.

This exercise will change the view in the current folder to [Detail], and will set

this as the default for all folders when they are opened in the future.

• Ensure that the [Folders] button is selected on the toolbar

• Click the [Views] button on the toolbar, and select [Details] from the menu

� To display the files in the [Contents] pane in [Detail] view

• From the menu bar, select [Tools] [Folder Options]

� The Folder Options dialog box will open

• At the top of the dialog box, select the [View] tab

• In the [Folder Views] section, click on [Apply to All Folders]

� To select this view as the default for all folders

Selecting [Reset All Folders] would reset all folders to the Windows XP

defaults

• Click on [Apply] and [OK]

� To put this change into effect

Note: For the following exercises, we will assume your computer has been set

to the [Details] view
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Exercise 19 Delete a file or folder

Delete a document file

• In the Folders pane, select [Form 4]

• In the Contents pane, select [Some balloons.bmp]

• From the menu bar, select [File] [Delete]

• Click [Yes]

� To confirm that you wish to send this file to the Recycle Bin

• In the Folders pane, select [Form 3]

• In the Contents pane, select [Some balloons.bmp]

• From the menu bar, select [File] [Delete]

• Click [Yes]

� To confirm that you wish to send this file to the Recycle Bin

Delete a folder

When you delete a folder, both the folder and the contents of the folder are

put into the Recycle Bin.

• In the Folders pane, select [Form 4]

• From the menu bar, select [File] [Delete]

• Click [Yes]

� To confirm that you wish to send this folder and all its contents to the

Recycle Bin
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Exercise 20 Use the Recycle Bin

Restore items

• Minimise all open windows

� To get back to the Windows Desktop

• Double click the [Recycle Bin] icon on the Windows Desktop

� The [Recycle Bin] window opens

• Select [Form 4] with a single click

• Select the [File] menu and [Restore]

� To “restore” that file

� To send that item back to its original place in the filing system

Tip:

The same procedure would be used to restore an individual file to its original

location in the filing system

Recycle Bin
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Empty the Recycle Bin

• Select the [File] menu and [Empty Recycle Bin]

� To see a confirmation message

• Select [Yes]

� To permanently delete those files

• [Close] the Recycle Bin

.
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Example 4 – Computer Settings

Exercise 21 Understand your settings

It is possible to view your computer’s basic system information, which is held

within the [Control Panel] of the computer.

• From the Taskbar, select [Start], [Control Panel]

� The Control Panel window opens

• If the window opens in [Category] view, select [Switch to Classic View] in

the left pane
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• Double Click the [System] icon

� The [System Properties] window opens

• Select the [General] tab

� To view the operating system and version number you are using

� To view the processor type in your computer

� To view the amount of installed RAM in your computer

• Close the Control Panel

Tip:

The other tabs contain further details of the setup of your computer, along with

the hardware you have attached to it. Amending this information can affect

the way your computer does (or doesn’t!) work, so take care when viewing

this information, and select [Cancel] to close the window without making any

changes.
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Exercise 22 Understand the way your desktop looks

• From the Taskbar, select [Start] [Control Panel]

� The Control Panel window opens

• Ensure the [Classic View] option is selected

• Double click the [Display] icon

� The [Display Properties] window opens

• Select the [Themes] tab

� To view and change the “look” of your windows

• Select the [Desktop] tab

� To view and change the background to be used on your Desktop

• Select the [Screen Saver] tab

� To view and change the screensaver options

• Select the [Appearance] tab

� To view and change the colour scheme that will be used in all your

windows

• Select the [Settings] tab

� To view and change the colour settings and screen resolution

• Click [Cancel]

� To close the window without making any changes

• [Close] the Control Panel
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Exercise 23 Language settings

• From the Taskbar, select [Start] [Control Panel]

� The Control Panel window opens

• Ensure the [Classic View] option is selected

• Double click the (Regional and Languages] icon

• Select the [Languages] tab

• Select [Details], and the [Settings] tab

• In the Installed services section, view the keyboard languages currently

installed on your computer

• If more than one keyboard language has been installed, an alternative

language can be selected, by clicking on it

• If you have access to your Windows disk, additional keyboard languages

can be installed by clicking the [Add…] button and following the

instructions to select further language(s) from your disk

• Click [Cancel]

� To exit the Text Services and Input Languages dialog box without

changing any settings

• [Cancel] out of the Regional and Language Options dialog box

• [Close] the Control Panel
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Exercise 24 Date and time settings

• Move the mouse pointer over the clock at the bottom right of the Taskbar

To see the current date

• Double click the left mouse button

� To open the Date and Time Properties dialog box

� To view and change the date and time details for your computer

(If your computer is networked, the date/time is automatically set

by the Server and should not be changed on your computer)

• Click [Cancel] to close the dialog box without making any changes

Exercise 25 Volume settings

Either

• From the Taskbar, select [Start] [Control Panel]

� The Control Panel quick menu opens

• Ensure the [Classic View] option is selected

• Click the [Sounds and Audio Devices] icon

� To view the Sounds and Audio Devices Properties dialog box

• Click the [Volume] tab

� To view and change the volume controls available on your computer

• [Cancel] the Sounds and Audio Devices Properties dialog box

Or

• If the [Volume] button is displayed at the bottom right of the Taskbar, move

the mouse pointer over the [Volume] button

• Double click the left mouse button

� To open the Volume Control dialog box

� To view and change the volume controls available on your computer

• [Close] the Volume Control dialog box
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Add the [Volume] button to the bottom of the Taskbar

• From the Taskbar, select the [Start] button and [Control Panel]

� The [Control Panel] window opens

• Ensure the [Classic View] option is selected

• Double click the [Sounds and Audio Devices] icon

• Ensure that the [Volume] tab is selected

• Click in the box to the left of the text [Place volume icon on the taskbar]

• Click [OK]

� The [Volume] button will appear on the taskbar next to the

clock

• Close the Control Panel
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Example 5 – Using Help

• From the Taskbar, select [Start] [Help and Support]

� The Windows Help and Support window will open

You can find the same Help subjects in a number of ways:

Use Search

There will be many, diverse topics available here, as the computer searches

throughout the Help manual to find the words you specify

• Click in the empty [Search] field at the top of the screen and type [save]

• Click on the [start searching] icon (white arrow)

� Search results will be shown in the left hand pane

• Scroll through the list of suggested topics

• Select [Save a file]

• View the help on saving a file in the right hand pane
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Use Index

The Index contains a list of alphabetical headings for the various help

functions

• Click on the [Index] icon at the top of the screen

� The [Index] field appears in the left hand pane

• In the [Index] keyword field, type [save] and press [Enter]

• From the list of results that is shown in the left hand pane, select [saving

files] [overview]

• Click [Display] to view the saving help in the right hand pane

Alternatively, you can scroll through the help Index in the left hand pane, to

find the keyword you require, and the topics associated with that keyword
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Help features

• Click the [Back] button on the toolbar

� To go back to the page you have just looked at

• Click the [Forward] button on the toolbar

� To go forward after going back

Print a help topic

• With the help topic you require on screen, click the [Print] icon

in the right hand pane above the help topic result

� The Print dialog box will open

• Select [Print]

• When you have finished, [Close] the Help and Support Center w
Forward
63

indow
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Exercise 26 Shut down the c

Shut down the computer

As with when you are restarting the computer, it is important that you always

shut the computer down properly.

• One by one, from the Taskbar, select any programs you are currently

working on

• For each program, select [File] [Exit] from the menu bar

� To ensure that each program, and any documents you are working on

in that program, are correctly closed

• Click the [Start] button on the Taskbar

• Select [Turn Off Computer…]

� The Turn Off Computer dialog box will open

• Select [Turn Off]

� To correctly shut down your computer

Some computers switch themselves off automatically once they have shut

down correctly.

If, however, you get a message on screen stating that it is “now safe to turn off

your computer”, it is important that you do not switch off each time until you

see this message.

"You can now safely turn 

off your computer" 
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